
About CyberKit

CyberKit (copyright 1996-1997 by Luc Neijens) is a combination of the following functions:

Ping can be used to verify whether a host is online. What does Ping do? Well it just sends a 
small message to the destination host. All hosts are supposed to bounce the message back, 
so if CyberKit receives the response you know the host is up and running.

TraceRoute shows you the route your connection takes. When you connect to a host it is 
almost never a direct connection. Most of the time you will pass through several different 
hosts before you arrive at your destination. TraceRoute will show you all the hosts along the 
way.

Finger and WhoIs are very simple Internet protocols. They are both used to retrieve information about 
hosts or users. To be able to use WhoIs or Finger a host must support them. Many hosts do!

Finger can be used to retrieve information about a user on a specific host (the provider). The information 
you get can differ from host to host. A user can even change his own information via the .plan file. Most of
the time you get things like: last login time, whether the user is currently logged on and on which terminal,
etc.
A user does not have to be a person, it can also be a machine. Try fingering coke@g.gp.cs.cmu.edu.

Whois is very similar to Finger. WhoIs is used with NIC (Network Information Center) servers. NIC 
servers provide large databases of users and hosts from all around the world. NIC gives you information 
about hosts and users that are registered.

Name Server LookUp can be used to resolve a Hostname or IP Address. It will also show you possible 
aliases. As a side-effect Name Server LookUp will also show you your own IP address and 
hostname.

Quote Of The Day will give you the quote of the day. Do you like these witty quotes? Try 
this one, you’ll like it!

Keep Alive will keep your connection open. Some providers will terminate your connection 
if there is no activity during a certain time. Keep Alive will periodically connect to a host and 
thus assuring some activity. The second light above the ‘Go’ button indicates the status of 
this function.

Check For New Mail can detect, and inform you, if there is new mail waiting for you. At this
moment, this function will    only work with the POP3 protocol. Check with your system 
administrator for more information about this protocol. The third light above the ‘Go’ button 
indicates the status of this function.



Privacy Issues

With the Internet and the growing interconnectivity between computers, privacy has become
a hot issue. Rumours about applications taking a snapshot of what is installed on your 
computer and then sending that information over the net to the manufacturer (without your 
knowledge) are at the least disturbing. 

I can assure you CyberKit does not send any information whatsoever over the line 
except for what is absolutely necessary to perform the requested function.
For example, when CyberKit is checking for new mail, it has to log on to your POP account. 
This includes sending userid and password over the line. I think it is clear that this can not 
be avoided. Your e-mail client will have to do the same. Just be aware that this is happening 
and change your password frequently! The password is kept in the registry on your 
computer. It is encrypted, but I'm not a cryptographer, so I can assure you that if someone 
with bad intentions has access to it, he will be able to decipher your password (even if I was 
a cryptographer, given enough time and computer power, any code can be broken!).



Copyright Information and Disclaimer

CyberKit is NOT Public Domain software.

CyberKit is postcardware. So if you like it, send me a postcard. Preferably one that has 
something to do with where you live.
There are no repercussions for not sending me a postcard, so if you find it too much trouble 
(you LAZYBONES!), you can still use CyberKit.

Please send the postcard to the following address:
Luc Neijens
Berkenlaan 8
3960 BREE
Belgium

Distribution and Restrictions
You are free to distribute CyberKit. Any such distribution must be limited to the original and 
unchanged archive.
You are NOT allowed to make any changes to CyberKit and you are NOT allowed to charge 
for distribution. You may NOT reverse engineer, decompile, or disassemble CyberKit.
If you have any doubts as to whether your actions are allowed, they probably aren’t and you
MUST check with me first!

DISCLAIMER
THE INFORMATION AND CODE PROVIDED IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS OR IMPLIED. IN NO EVENT SHALL LUC NEIJENS BE LIABLE FOR ANY 
DAMAGES WHATSOEVER INCLUDING DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, LOSS
OF BUSINESS PROFITS OR SPECIAL DAMAGES, EVEN IF THE AUTHOR HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES.
DO NOT USE CYBERKIT UNLESS YOU CAN FULLY AGREE WITH THIS DISCLAIMER.

CyberKit, copyright 1996-1997 by Luc Neijens. All rights reserved.



Postcardware

Postcardware is almost freeware. If you try out a postcardware program, and decide that you’d like to use
it on a regular basis, you then just send a postcard to the development team or programmer.



Lights

 3 lights
Just above the ‘Go’ button you can see 3 lights.
The first indicates that one of the functions: Ping, TraceRoute, Finger, WhoIs, Name Server 
LookUp or Quote of the Day is active. The second is used by the Keep Alive function and the 
last is used by the Check For New Mail function.
A green light indicates the function is active, a red light indicates something went wrong. For
the latter,    you will want to set the ‘Show me what’s happening’ option, to see what is going
on.



Installing/Un-Installing CyberKit

Installing CyberKit
- Unzip the archive Cyber.zip in a temporary directory.
- Click on the Start button on the Taskbar.
- Click on the Start menu's "Run" selection.
- Type the path to the unzipped files followed by "\SETUP.EXE".
- Click on the "OK" button.
- Follow the on-screen prompts to complete the installation.

Or if you’re using WinZip: Just open Cyber.zip and select ‘Install’.

Un-Installing CyberKit
- Open the control panel.
- Double click on the ‘Add/Remove Programs’ icon.
- You will see a list of installed software, select CyberKit on the list.
- Click on the “Add/Remove” button.
- Follow the on-screen prompts to complete the un-installation.



FAQ (Frequently Asked Questions)

Can you point me to some ‘Quote of the Day’ servers?
At this time I know of 2 ‘Quote of the Day’ servers: www.rmm.com and www.engen.com. Feel free to 
report other servers, so I can include them here and in the default Addressbook.

How can I configure CyberKit to use Microsoft    Internet Mail as my E-Mail reader?
Go to The Mail Options Tab and specify the following as your E-Mail Program: "C:\WINDOWS\
EXPLORER.EXE" /root,C:\WINDOWS\Internet Mail.{89292102-4755-11cf-9DC2-00AA006C2B84}

How can I ping myself?
You can always ping your own computer by using the address 127.0.0.1. As a shortcut you can use ‘me’ 
or ‘myself’ as hostname.

How can I start CyberKit minimized in the tray?
Use the /M command line   parameter  , and set the ‘Minimize To Tray’ option in The General Options 
Tab.

How do I install CyberKit?
Refer to the Install/Un-Install section for instructions.

How do I un-install CyberKit?
Refer to the Install/Un-Install section for instructions.

How do I know if a host supports Finger or WhoIs?
Just try, if you cannot connect, the host probably does not support them (at least if the host is not down).

How do I report a problem?
Refer to the Problem Reports section for instructions.

What do I need to use CyberKit?
Windows 95 or Windows NT.
If you want to use the Ping or and/or TraceRoute functions, you need the ICMP.DLL somewhere in your 
path (usually located in your system directory, which is OK). Ping and TraceRoute often don’t work when 
you are not using the Microsoft Winsock, so if you are having trouble with these functions check the 
winsock version you are using.

What is the difference between Finger and WhoIs?
Not much!
WhoIs tends to give you more in-depth data. With WhoIs you are connecting to a NIC server. WhoIs will 
only provide the information which is registered at the NIC server.
With Finger most of the time you are connecting to the provider of the user you are fingering. Finger can 
provide you with login information.

Where can I get a copy of ICMP.DLL?
ICMP.DLL comes with Windows 95 and Windows NT.

Where can I get the latest release of CyberKit?
Read the New Releases section for more information.

Why are the Ping and the TraceRoute pages ‘grayed’ out?
Ping and TraceRoute require ICMP.DLL somewhere in your path. When something goes wrong with 
loading this DLL, these two pages will be ‘grayed’ out. You should make sure the DLL is in your path and 
you are using the Microsoft Sockets stack.



Related topics: Tips and Tricks, Trouble Shooting, Problem Reports



Tips and Tricks

Adding an address to the addressbook
If you open The Addressbook it will initialize the ‘new host’ field with the contents of the ‘host’ and ‘user’ 
field of the active function. This way you only have to click ‘Add’ to add the last used address to the 
addressbook.

Adding CyberKit to the StartUp menu
If you want to start CyberKit everytime you start your computer, here’s how you do it:
- Click on the Start button on the Taskbar
- Select ‘Settings’ and next ‘Taskbar’
- Select ‘Start Menu Programs’
- Select ‘Add’
- Select ‘Browse’ and locate CyberKit.exe, next select ‘Open’
- You will see something like ‘C:\CyberKit\CyberKit.exe’ (this can differ depending on the directory you 

installed CyberKit in). Add -M to the end of the line. You will have something like C:\CyberKit\
CyberKit.exe -M. This will make sure CyberKit starts minimized in the Tray.

- Select ‘Next’
- Locate and select the ‘StartUp’ folder
- Select ‘Next’
- Change the name for the shortcut to ‘CyberKit’
- Select ‘Finish’

Context sensitive help
CyberKit has context sensitive help. This means that if you press F1 from within for example 
TraceRoute, you’ll get help about ‘TraceRoute’.

Entering user and host name
If you have the option ‘Smart Address Splitting’ selected, you don’t have to enter user and host name 
separately. Just enter (or paste from the clipboard) an e-mail address and let CyberKit do the splitting for 
you. ‘Smart Address Splitting’ can also filter the host name out of an url (http://…) or ftp (ftp://…) address.

Help function for WhoIs servers
Most WhoIs servers have a help function. Just enter help as user name and the server will return help 
information.

Login information
Most finger servers return a list of users with login information if you leave the user name blank.

Obtaining a recent list of WhoIs servers
To get a recent list of WhoIs servers, use 'sipb.mit.edu' for host name and ‘WhoIs-servers’ for user name.
You will also find this address in the default addressbook that comes with CyberKit.

Remember Last Function
You can let CyberKit remember the last used function by checking the ‘Remember Last Function’ field in 
The Options Menu. If you now start CyberKit, it will automatically switch to the last used function (Ping, 
Finger, whatever).

Remember Last Window Position
You can let CyberKit remember its window size and position by checking the ‘Remember Window 
Position’ field in The Options Menu. If you now start CyberKit, it will start at its last screen location 
(minimized, maximized, whatever).

Smart address splitting
Make your life easy and let CyberKit split the addresses for you. This way you can simply paste an e-mail 



address in the host or user field and CyberKit will split it up for you. Try it, you’ll like it!

Using non-proportial fonts
The query output will look nicer if you use a non proportional font like courier or terminal. You can change 
the font from The Options Menu.

Related topics: Trouble Shooting, FAQ (Frequently Asked Questions), Problem Reports



Trouble Shooting

‘Cannot connect’ messages
These messages usually indicate that the server does not support the requested function. 
For example, there are very few Quote of the Day servers out there. If you use any other 
host in this client, it will cause this error message to be displayed.

Firewall problems
If you’re behind a firewall you may not be able to use CyberKit. This is not a problem of 
CyberKit, but a property of firewalls. Your network manager should be able to answer your 
questions. I know it is possible to configure a firewall to use finger or whois (don’t ask me 
how because I don’t have any experience with it). However your network manager may 
choose not to do so because of security regulations.

Ping and TraceRoute problems
Ping and TraceRoute both require the presence of ICMP.DLL somewhere in your path. The 
system directory under windows would be a good choice.
Ping and TraceRoute may not work properly if you don’t use the Microsoft winsock. At this 
moment there are no plans to fix this. If you want to use CyberKit consider using the 
Microsoft winsock.

Winsock support
CyberKit is written for the Microsoft winsock that comes with Windows 95 or NT. It might not 
work properly with other winsock stacks.

Other problem?
Most questions/problems can be solved by reading the help file first. I’ve put a lot of effort in
it, so please use it! I can assure you that answering the same questions day after day, while 
I know the answer is in the help file, is pretty frustrating. Read the Tips and Tricks and the 
FAQ (Frequently Asked Questions) sections first, next try to do a find on a keyword.
Ask yourself whether I’m the right person to answer your question. If your question is not 
specifically linked to using CyberKit, use the internet! There are plenty information sources 
out there about programming, networking, sockets, TCP/IP, etc. with more information than I 
can possible provide.
You can reach me by e-mail at the following address: Luc.Neijens@ping.be.

Related topics: Tips and Tricks, FAQ (Frequently Asked Questions), Problem Reports



Problem Reports

Before reporting a problem
- If you have a problem with a beta, make sure you’re running the latest beta.
- Read the help file, especially the Tips and Tricks, the FAQ (Frequently Asked Questions) and 

the Trouble Shooting sections.
- Visit the CyberKit homepage (http://www.ping.be/user/Luc.Neijens) and make sure your 

problem is not already reported.

The information I need
- What OS are your running and what version: Windows 95, Windows NT 3.51/4.0?
- What winsock are you using (use the CyberKit view menu to find out)?
- Describe in detail what you did, what function you were using, what input you provided 

(addresses, host name, options).
- Note down in detail any messages (statusbar, dialog, etc.) you got from CyberKit.
- Can you reproduce the problem? If yes, please provide a detailed description on how to 

reproduce it.
- Are you willing to provide additional information if needed?
- Any other information you think may be relevant.

Please do not send me large attachments unless I specifically ask for them!

Send this information by e-mail to: Luc.Neijens@ping.be.

Related topics: Trouble Shooting, Tips and Tricks, FAQ (Frequently Asked Questions)



New Releases

The latest release can always be downloaded from the CyberKit homepage.
I also keep a list of users that want to be kept informed by e-mail of new releases. If you 
want me to put you on this list, let me know. Actually, my E-Mail client is starting to give my 
problems with this list. So in the future we may have to find some other way of doing this 
(maybe a real mailing list?).

Beta releases
Beta releases are intermediate releases. They have not been fully tested and are likely to 
contain bugs. If you’re not entirely at ease with beta releases, please do not use them! If, 
however, you don’t mind a bug now and then, you can help me greatly by using the beta 
release and reporting any problems you may encounter.

New features
I need your input to keep CyberKit alive. Any bright ideas to make CyberKit better? Let me 
know! I promise I will consider all suggestions, however I reserve the right for the final 
decision.

Problems
Read the Problem Reports section.

Where to reach me
You can reach me by e-mail at the following address: Luc.Neijens@ping.be
You can find the CyberKit homepage at: http://www.ping.be/user/Luc.Neijens/



The Ping Page

To PING a host, do one of the following and press <enter> or select the Go button:
- Enter an address in the ‘Host or Address’ field. You can also cut the address from somewhere else and 

paste it in the ‘Host or Address’ field.
- Select an address from the drop down menu.
- Open the addressbook with F12 and double-click on the address to use.

You can set any of the following options:
- ‘Timeout’: the time, in seconds, CyberKit will wait for a response.
- ‘Delay’: the interval, in milliseconds, between pings.
- ‘Packet Size’: the size, in bytes, of a ping message.
- ‘Number of Pings’: the number of times you want to ping the host.
- ‘Resolve IP Addresses’: whether you want CyberKit to resolve the IP addresses for you. Unlike with the 

TraceRoute client this will not save you a lot of time, but it is there if you want to use it. If you choose to
use it, you can always resolve the IP addresses later by double clicking on the sequence number for the
host.

To ping yourself, enter ‘me’ or ‘myself’ as hostname.

For each ping, you will receive the following information:
Number: The sequence number of the host in the Route.
Address: The IP address of the host. If this address is in brackets, the response came from a bad host. 
This can indicate there is a ‘loop’ somewhere that causes the message to be bounced between several 
hosts. You can use the the TraceRoute client to locate this ‘loop’.
Host Name: The name of the host.
Response Time: The time between the moment CyberKit sends the echo message to the remote host 
and the moment CyberKit receives the response.

How Ping works



Ping verifies a connection to a remote host by sending an ICMP (Internet Control Message Protocol) 
ECHO packet to the host and listening for an ECHO REPLY packet.
A message is always sent to an IP address. If you do not specify an address but a host name, this host 
name is resolved to an IP address using your default DNS server. In this case you’re vulnerable to a 
possible invalid entry on your DNS (Domain Name Server) server. You can simulate this resolving by 
using the Name Server LookUp client and a search type of ‘Use Winsock Function GetHostByX’.
The ECHO REPLY packet is validated against this IP address to make sure is was originated by the 
correct host. If they don’t match, the originating IP address is placed between brackets to indicate a 
possible problem. The host name that is displayed is obtained by resolving the originating IP address 
using your default DNS server.

Related topics: The TraceRoute client, The Name Server LookUp client



The TraceRoute Page

To Trace the Route to a host, do one of the following and press <enter> or select to Go button:
- Enter an address in the ‘Host or Address’ field. You can also cut the address from somewhere else and 

paste it in the ‘Host or Address’ field.
- Select an address from the drop down menu.
- Open the addressbook with F12 and double-click on the address to use.

You can set any of the following options:
- ‘Timeout’: the time, in seconds, CyberKit will wait for a response.
- ‘Start From Hop’: set this to ‘1’ if you want to start with the first hop. TIP: If for your ISP (Internet 

Service Provider) the first hop never responds, set this to ‘2’.
- ‘Maximum Hops’: the maximum number of hops to trace. In fact, this is the maximum value for TTL.
- ‘Resolve IP Addresses’: whether you want CyberKit to resolve the IP addresses for you. Unlike with the 

Ping client this can speed things up considerably. If you choose to use this option, you can always 
resolve the IP addresses later by double clicking on the sequence number for the host.

For each host along the route, you will receive the following information:
Number: The sequence number of the host in the Route.
Address: The IP address of the host.
Host Name: The name of the host.
Response Time: The time between the moment CyberKit sends the echo message to the remote host 
and the moment CyberKit receives the response.

How TraceRoute works
TraceRoute determines the route taken to a destination by sending ICMP (Internet Control Message 
Protocol) ECHO packets with varying TTL (Time To Live) values to the destination.
Each router along the path is required to decrement the TTL on a packet by at least 1 before forwarding it,
so the TTL is effectively a hop count. When the TTL on a packet reaches 0, the router is supposed to 
send back an ICMP Time Exceeded message to TraceRoute.



TraceRoute determines the route by sending the first echo packet with a TTL of 1 and incrementing the 
TTL by 1 on each subsequent transmission until the target responds or the maximum TTL (=Maximum 
Hops) is reached. The route is determined by examining the ICMP Time Exceeded messages sent back 
by intermediate routers. Notice that some routers silently drop packets with expired time-to-live (TTLs) 
and will be invisible to TraceRoute (you will get a ‘No response from this host’ entry).
The host name that is displayed is obtained by resolving the originating IP address for the ICMP Time 
Exceeded message using your default DNS (Domain Name Server) server.

Related topics: The Ping client, The Name Server LookUp client



The Finger Page

To Finger a person, or host, do one of the following and press <enter> or select the Go button:
- Enter an e-mail address in the ‘Host or Address’ or ‘User’ field. You can also cut the address from 

somewhere else and paste it in one of the above fields.
- Enter a hostname in the ‘Host or Address’ field.
- Select a hostname or e-mail address from the drop down menu.
- Open the addressbook with F12 and double-click on the address to use.

If you select the ‘Clear Output’ field, the output will be cleared for each Finger request.
Some hosts will return more information if you select the ‘Verbose Format’ field. A host that does not 
support this option is supposed to ignore it. Some hosts, however, will interpret this option as part of the 
user name and return an error message like "Illegal character in username". If you encounter this 
problem, unselect the ‘Verbose Format’ field and try again.
To change the font select ‘Output Font’ from the Options Menu.



The WhoIs Page

To use WhoIs, do one of the following and press <enter> or select the Go button:
- Enter an hostname in the ‘Host or Address’ and a search string or command in the ‘User’ field. You can 

also cut the information from somewhere else and paste it in one of the above fields.
- Enter a hostname in the ‘Host or Address’ field.
- Select a hostname or hostname and command from the drop down menu.
- Open the addressbook with F12 and double-click on the address to use.

If you select the ‘Clear Output’ field, the output will be cleared for each WhoIs request.
To change the font select ‘Output Font’ from the Options Menu.

There are many different parameters and keywords, that you can use in a WhoIs query. Most servers will 
return a detailed description of the different types of query when you enter a ‘?’ or ‘HELP’ in the user 
field.



The Name Server LookUp Page

To Resolve a Hostname or IP Address, do one of the following and press <enter> or select the Go 
button:
- Enter the address you want to resolve. You can use one of the following methods for this:

- Enter an address in the ‘Host or Address’ field. You can also cut the address from somewhere else 
and paste it in the ‘Host or Address’ field.

- Select an address from the drop down menu.
- Open the addressbook with F12 and double-click on the address to use.

- Specify the type of Search:
- Specify ‘Use Winsock Function GetHostByX’ to use the standard resolve function (this function is 

used by most applications, like your browser, email program etc. and the other client functions in 
CyberKit). This function always uses the default DNS server as specified in the network settings of 
your computer.

- You can also interrogate any other DNS server on the net for specific resource records. Just select 
the resource record in the ‘Type of Search’ field and enter the address or hostname of the DNS 
server in the ‘Name Server’ field.

If you select the ‘Clear Output’ field, the output will be cleared for each request.
If you select the ‘Verbose Format’ field, you will get a more detailed output.
To change the font select ‘Output Font’ from the Options Menu.

Related topics: The Ping client, The TraceRoute client



The Quote Of The Day Page

To get the ‘quote of the day’, do one of the following and press <enter> or select the Go button:
- Enter an address in the ‘Host or Address’ field. You can also cut the address from somewhere else and 

paste it in the ‘Host or Address’ field.
- Select an address from the drop down menu.
- Open the addressbook with F12 and double-click on the address to use.

If you select the ‘Clear Output’ field, the output will be cleared for each request.
To change the font select ‘Output Font’ from the Options Menu.



The Addressbook

This addressbook can be used for any of the functions within CyberKit.
The addressbook is located in the CyberKit directory under the name CyberKit.pbk.
The default addressbook, also located in the CyberKit directory, is named CyberKit.def and is renamed to 
CyberKit.pbk if CyberKit.pbk is not present. This procedure makes sure you retain your old addressbook 
when you install a new release of CyberKit.

If you ever need to fall back on the default addressbook, take the following steps:
- Backup the CyberKit.pbk file and remove it afterwards
- If CyberKit.def is not present, you will have to re-install CyberKit. During installation choose for Custom 

Install and only install the addressbook
- Restart CyberKit

Adding an address
Enter the new address in the ‘Add’ field and select the Add button.

Adding or changing notes for an address
Select the address you want to add the notes to, in the ‘Addresses’ list and enter your notes in the 
‘Notes’ field.

Removing an address
Select the address you want to remove, in the ‘Addresses’ list and select the Remove button.

Using an address
Double click on the address you want to use or select the address you want to use, in the ‘Addresses’ list
and select the Use button.

Getting help
Select the Help button.

Closing the addressbook
Select the Close button.



The Options Dialog

You can make CyberKit behave just like you want it to.

From The General Options Tab you can configure the Keep Alive function, the firewalls, how you want 
CyberKit to behave if you minimize it and more.

From The Mail Options Tab you can customize the Check For New Mail function.

From The RAS Options Tab you can customize the RAS settings.



The General Options Tab

Use the following options to customize CyberKit the way you like it:
General Options:
- ‘Remember Window Position’: Check this if you want CyberKit to remember its window position. This 

way CyberKit will start where you last left it.
- ‘Remember Last Function’: Check this if you want CyberKit to remember the last used function. This 

way CyberKit will start with the last used function.
- ‘Smart Address Splitting’: Check this if you want CyberKit to automatically split addresses at the @ sign 

when entered in the Finger or WhoIs client. This is very useful when you paste email addresses in the 
host or user field. CyberKit will also filter the hostname out of a url (http://…) or ftp (ftp://…) address if 
you enable this option.

- ‘Minimize To Tray’ (not available on Windows NT 3.51 and lower): Check this if you want CyberKit to 
minimize to the tray. CyberKit will add an icon to the tray and when you minimize CyberKit, it will remove
itself from the taskbar. The icon will show a little lightning flash whenever CyberKit is doing something. 
The colour of this lightning flash indicates what is happening:
Yellow: A client function is active (Ping, TraceRoute, ect.)
Green: CyberKit is checking for new mail.
Blue: CyberKit is keeping your connection alive.
Red: CyberKit is dialing your connection.

If you left click on the tray icon, CyberKit will restore itself to its last position.



If you right click on the tray icon, you will get a popup menu from which you can choose a function like: 
Restore to Ping, Check for Mail, etc. Also you can dial your DialUp Connections from here.

Firewalls:
- ‘Finger Firewall’: If you have to use a firewall for Finger, enter it here.
- ‘WhoIs Firewall’: If you have to use a firewall for WhoIs, enter it here.

Keep Alive:
- ‘Send KeepAlive Messages’: Check this if you want CyberKit to keep your connection alive. The 

second light above the ‘Go’ button indicates the status of this function.
- ‘Send every x minutes’: Specify the interval between keep alive messages.
- ‘Use host’: Specify the host to connect to. CyberKit will connect to this host using the HTTP protocol. 

You must enter a WWW host in here, for example the WWW host of your own provider. If you leave this 
field blank, Keep Alive will not work.

- ‘Show me what is happening’: If you check this, CyberKit will show you what is happening in a little 
dialog box. Use this when you are having trouble with this function to see what is going wrong.
When this option is enabled, CyberKit will also create a small log file in the CyberKit directory. The name
of the log file is KeepAlve.log, and it contains all the messages shown in the dialog. You can use any 
editor to view this log file.

Related topics: The Mail Options Tab, The RAS Options Tab



The Mail Options Tab

Use the following options to customize ‘Check For New Mail’ the way you like it:
- ‘Check For New Mail’: Check this if you want CyberKit to check for new mail. At this time only the POP3 

protocol is supported. Check with your system administrator for more information about the POP3 
protocol. The third light above the ‘Go’ button indicates the status of this function.

- ‘Check Every x Minutes’: Specify how often CyberKit has to check for new mail.
- ‘Check at startup’: Check this if you want CyberKit to check for new mail when you start it.
- ‘E-Mail Reader’: If you enter the full path and filename for your E-Mail reader here, a left click on the 

new mail icon in the tray will launch your E-Mail reader. If the path or filename of your E-Mail reader 
contains spaces, you’ll have to enclose it with double quotes. Any command line parameters must be 
separated by a space and located outside the quotes.
If you’re an Internet Mail user, try this: "C:\WINDOWS\EXPLORER.EXE" /root,C:\WINDOWS\Internet 
Mail.{89292102-4755-11cf-9DC2-00AA006C2B84}

- ‘POP Host’: Enter your POP host here.
- ‘Username’: Enter your username here.
- ‘Password’: Enter your password here.
- ‘Show me what is happening’: If you check this, CyberKit will show you what is happening in a little 

dialog box. Use this when you are having trouble with this function to see what is going wrong.
When this option is enabled, CyberKit will also create a small log file in the CyberKit directory. The name
of the log file is Mail.log, and it contains all the messages shown in the dialog. You can use any editor to 
view this log file.

When mail is waiting:
- ‘Only Notify Once’: If you enable this option, CyberKit will only notify you once of new mail. The number 

of messages for the tray icon will still be updated.
- ‘Play a sound’: Enter any .wav file you want. If you don’t specify any .wav file, CyberKit will use the 



default PC-speaker beep.
- ‘Add an icon to the tray’ (not available on Windows NT 3.51 and lower): CyberKit will add an icon to the 

Tray when there is mail waiting for you. If you provide the name of your E-Mail reader, a left click on this 
icon will launch your E-Mail reader for you.

- ‘Use an alert dialog box’: CyberKit will pop up a dialog box when there is mail waiting for you.

Remarks:
- This function will not work correctly if you leave your mail on the server.
- CyberKit will NOT notify you of new mail in the following cases:

- The number of messages AND the size of these messages have not changed since the last check.
- The number of messages has grown since the last check and you have the ‘Only Notify Once’ option

enabled (this does not apply if the number of messages in the last check was zero).

Related topics: The General Options Tab, The RAS Options Tab



The RAS Options Tab

Use the following options to customize ‘RAS’ the way you like it:
- ‘Don’t dial for ‘Keep Alive’ and ‘Check For New Mail’’: If you set the ‘Keep Alive’ or ‘Check For New 

Mail’ option, CyberKit will periodically connect to your ISP. If you’re not connected, CyberKit will connect
for you. If you don’t want CyberKit to dial the connection for you, check this option. This way, CyberKit 
will only use the ‘Keep Alive’ or ‘Check For New Mail’ function when the specified DialUp connection is 
already active.

- ‘DialUp Connection’: Specify the required DialUp connection for ‘Keep Alive’ and ‘Check For New Mail’.
If you select the ‘Don’t dial …’ option, CyberKit will only perform the above functions when this DialUp 
connection is active. If you select ‘Any Connection’, any active connection will suffice.

Related topics: The General Options Tab, The Mail Options Tab



The Command Line Parameters

You can use the following command line parameters with CyberKit:

-P ‘address’
Tells CyberKit to ping ‘address’.
For example CyberKit -P www.ping.be or CyberKit -P if you just want CyberKit to start with the Ping 
screen.

-T ‘address’
Tells CyberKit to trace the route to ‘address’.
For example CyberKit -T www.ping.be or CyberKit -T if you just want CyberKit to start with the 
TraceRoute screen.

-F ‘user@host’
Tells CyberKit to finger ‘user@host’.
For example CyberKit -F coke@g.gp.cs.cmu.edu or CyberKit -F if you just want CyberKit to start with the 
Finger screen.

-W ‘command@host’
Tells CyberKit to execute the WhoIs command ‘command’ at host ‘host’.
For example CyberKit -W WhoIs-Servers@sipb.mit.edu or CyberKit -W if you just want CyberKit to start 
with the WhoIs screen.

-N ‘address’.
Tells CyberKit to resolve ‘address’.
For example CyberKit -N www.ping.be or CyberKit -N if you just want CyberKit to start with the Name 
Server LookUp screen.

-Q ‘address’.
Tells CyberKit to get the quote of the day from ‘address’.
For example CyberKit -Q www.rmm.com or CyberKit -Q if you just want CyberKit to start with the Quote 
Of The Day screen.

-M
This will start CyberKit minimized as a Tray Icon. Not available on Windows NT 3.51 and lower.
For example CyberKit -M.



The CyberKit Menu

There are four available menus:

The File Menu:
Dial …: Submenu that contains your dial-up connections. Select the connection that you want to dial. If 
you have more than 10 dial-up connections, this menu item will open a dialog box containing all your dial-
up connections.
Save: Saves the information on the page to a file.
Copy results to Clipboard: Copies the information on the page to the clipboard for use outside CyberKit.
Print: Prints the information on the page.
Check for Mail: Checks whether there is new mail waiting for you.
Clear Recent List: Choose this menu item to clear the recent list of the active function.
Exit: Close the CyberKit program

The Options Menu:
Settings: Choose this menu item to activate the Options Dialog.
Output Font: Choose this menu item to change the Output Font.

The View Menu:
Winsock Information: Select this menu item to see your the socket release you are using.
Addressbook: Choose this menu item to activate the Addressbook

The Help Menu:
Contents: Select this menu item to see the help contents.
Help on Help: Select this menu item to see the windows help file about how to use help.
Go Online and …:

- Visit CyberKit Homepage: This will start your Web Browser and point it to the CyberKit HomePage. 
Use this to go online and check for new releases, bug reports, etc.

- Give Feedback: This will start your e-mail program so you can send me a message with your 
feedback information.

About CyberKit: Select this menu item to see the about box.




